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Section 5 
Slide Shows 

By the end of this Section you should be able to: 

Create and Edit Action Buttons/Hyperlinks 

Create and Edit Custom Shows 

Run a Custom Show 

Apply Slide Transitions 

Apply Timings 

Set up a Slide Show 

Use Various Techniques while Running a Show 

 
 

To gain an understanding of the above features, work through the Driving 
Lessons in this Section. 
For each Driving Lesson, read the Park and Read instructions, without 
touching the keyboard, then work through the numbered steps of the 
Manoeuvres on the computer. Complete the Revision Exercise(s) at the end of 
the section to test your knowledge. 
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Driving Lesson 39 - Action Buttons 

 Park and Read 
Action buttons can be added to allow rapid and easy navigation between 
slides during the presentation using hyperlinks. Action buttons also allow 
movement to other presentations, files, web sites and various other 
destinations.  

 Manoeuvres 
1. Open the Training presentation and save it as Training2. 

2. Select slide 4, The Open Learning Guide. 

3. To create an action button that links to slide 7, click the Shapes 
button on the Home tab, look in the Action Buttons section of the 
list and select the Information action button, . 

4. Click and drag the shape of the button on the bottom left side of the slide. 

 If a message appears about saving the presentation, select Yes. 

5. The Action Settings dialog box appears. Ensure that the Mouse Click 
tab is selected. Click the Hyperlink to option, scroll down the drop down 
list and select Slide….  

6. A list of slides in the presentation is displayed, select slide 7 Where to 
Get More Information.   

 
7. Click OK, and then OK to close the dialog box. 

 To remove a hyperlink, display the Action Settings dialog box for the object 
containing the link and select None from Action on click. 
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Driving Lesson 39 - Continued 
8. Click the Slide Show tab and select From Current Slide to see the slide 

as it will appear in the presentation. 

9. When the cursor appears, click the action button. The presentation moves 
to the Where to Get More Information slide. 

10. The presentation will continue from its new position (there is no automatic 
return to the original slide). Click until the show is ended. 

11. With slide 7 displayed in Normal View, draw a Custom action button, , 
which will link to a separate presentation. 

12. In the Action Settings dialog box, select Hyperlink to and then Other 
PowerPoint Presentation. 

13. Select CIA Seminar from the list. 

14. Click OK and ensure Hyperlink to Slide shows Slide 1 highlighted and 
then click OK. 

15. Click OK to create the link and with the button selected type CiA so it is 
labelled. 

 

16. View the slide show and test the button. Click to view the CIA show. End 
the CIA show to return to the Training2 show. 

17. Press <Esc> to end that show and return to Normal View. 

18. At the bottom left of slide 5 draw a Document action button, . This will 
link to a Word document. 

19. From Action Settings select Hyperlink to then Other File. 

20. Choose the Sample file and click OK then OK again. 

21. Add the text Sample to the button. Enlarge the button if necessary. 

22. Run the show and after the text has loaded click the Sample action 
button. Word starts and opens the document. 

23. Close Word, without saving if prompted and end the show. 
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Driving Lesson 39 - Continued 
24. Hyperlinks links can also be applied to text or graphical objects - you don’t 

always have to use action buttons. Display slide 7 and select the text 
Information. 

25. Display the Insert tab and click the Hyperlink button from the 
Links group. 

26. Make sure Existing File or Web Page is selected on the left and type 
www.ciatraining.co.uk in the Address box. PowerPoint adds the 
necessary components to make this a valid web address. 

 

27. Click OK. The text Information is displayed in a different colour to 
indicate it is a hyperlink. 

28. Run the show from slide 7. Move the cursor over the Information text. 
The cursor changes to a hand. 

29. Click on the text. If an Internet connection exists, your browser application 
will start and the CiA Training home page will be displayed. 

30. Close the browser window and end the slide show. 

31. Save the presentation and leave it open. 
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Driving Lesson 40 - Editing an Action Button 

 Park and Read 
It is possible to change the destination of an action button or any hyperlink, 
after creating it. This may be necessary for example if a web address (URL) or 
a file location changes. 

 Manoeuvres 
1. On slide 7 right click on the CiA action button, (take care not to click on 

the text content, you need to click part of the button itself). 

2. Select Edit Hyperlink. The current hyperlink destination is shown. 

3. To change the link to a different presentation, click the Hyperlink to drop 
down list. 

 
4. Click on Other PowerPoint Presentation. 

5. Select the Holiday Choice presentation from the data files and click OK, 
then OK again to accept Slide 1 as the destination of the link. 

6. Click OK in the Action Settings dialog box. 

7. View the slide show for this slide and when the text has loaded click the 
button to view the linked presentation. 

8. End both shows. 

9. On slide 7 right click on the word Information. 

 

 Notice there is an option here to Remove the hyperlinks from this text. 

10. Select Edit Hyperlink. 

 



Section 5 Slide Shows ECDL/ICDL PowerPoint 2007 

©  CiA Training Ltd 2009 76 Module AM6 Presentations Advanced Level 

Driving Lesson 40 - Continued 

 There is also an option here to Remove the link from this text. 

11. Highlight the text in the Address box and type www.ecdl.com. Click OK. 

12. Run the show from slide 7. Click on the Information text. If a connection 
exists your browser application will start and the ECDL home page will be 
displayed. 

 

 The appearance of the web page was correct at time of writing. It may change 
over time. 

13. Close the browser window and end the slide show. 

14. On slide 7, right click on the CiA button and select Remove Hyperlink. 

15. Run the show from slide 7. Click on the CiA button text. The button no 
longer contains a hyperlink and there will be no action. 

16. End the show. 

17. Close the presentation without saving. 
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Driving Lesson 41 - Custom Shows 

 Park and Read 
Custom shows allow different parts of one presentation to be shown as different 
shows to different audiences without the need for creating multiple versions of 
the same presentation. For example, an audience of salespeople could see a 
presentation without seeing those slides relating to administration and training, 
and finance staff could be given the same presentation, but without the sales 
and training slides. A custom show can be set up so that certain slides can be 
missed out when necessary. 

 Manoeuvres 
1. Open the Business presentation. 

2. On the Insert tab, select Header & Footer, check the box to 
include Slide number and click Apply to All. 

3. Save the presentation as Custom. 

4. The presentation is to be shown to two departments of the same 
company: Finance and Marketing. To avoid the creation of two separate 
presentations, two custom shows are to be created, each showing a 
different selection of slides. 

5. On the Slide Show tab, select Custom Slide Show then Custom Shows 
to display the Custom Shows dialog box. Click the New button to open 
the Define Custom Show dialog box. 

6. Name the custom show Finance as this is the show to be given to that 
department. 

 

 
 

 



Section 5 Slide Shows ECDL/ICDL PowerPoint 2007 

©  CiA Training Ltd 2009 78 Module AM6 Presentations Advanced Level 

Driving Lesson 41 - Continued 
7. The Finance people do not need to see all of the Marketing slides. Select 

the first slide, then click Add. 

8. Select slide 2 and then hold down <Ctrl> as you select slides 4, 9, 11 and 
12. Click Add to add them to the custom show. 

 
9. Click OK to return to the Custom Shows dialog box. 

10. Create another custom show called Marketing (slides 1, 2, 3, 4, 6, 7 and 
12).  Click OK. 

11. To edit the Marketing department’s show, select Marketing from the list 
in the Custom Shows dialog box and click Edit. 

12. Click on slide 6 Business Concept at the right of the dialog box. 

 
13. Click Remove. 

14. Slide 4 The Team is to be moved after Opportunities. Select slide 4 from 
the right of the dialog box. 

15. Click Move Down, . 

16. Click OK and then Close. 

17. Save the presentation and leave it open. 
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Driving Lesson 42 - Running a Custom Show 

 Park and Read 
After custom shows have been created they can be run via the menus, or more 
professionally by adding action buttons to the presentation. 

 Manoeuvres 
1. View slide 1 of the Custom presentation in Normal View, display the 

Slide Show tab and click Custom Slide Show. 

 

2. To run the Finance show, select it from the list. 

3. Click the mouse to advance the slides, noting which slides are displayed, 
and click to exit. 

4. View the Marketing show in the same way. 

5. To create a copy of the Marketing show, click Custom Slide Show and 
select Custom Shows. 

6. Select the Marketing show and click Copy.  

7. The new show Copy of Marketing appears below the others. Click on it 
and select Edit. 

8. Change the name to Directors and click OK. 

 

9. A copy is not actually needed. Select Directors and click Remove. Close 
the Custom Shows dialog box. 
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Driving Lesson 42 - Continued 
10. It would be better to select the required show by using action buttons on 

the first slide. Insert an Action Button:Custom at the lower left of slide 1. 

11. Select Hyperlink to and from the list select Custom Show | Finance 
then click OK and OK again. 

12. With the button selected type in Finance. Click away from the button. 

13. Repeat the above steps to create a button for the Marketing custom show 
at the right of the first button. 

14. Resize and move the buttons as necessary. 

15. Because slide 1 will now always be displayed in order to start the custom 
shows, you may want to remove it from each show sequence. To remove 
slide 1, click Custom Slide Show, and select Custom Shows. 

16. Select the Finance show and click the Edit button. 

17. Select slide 1 from the list on the right and click Remove. Click OK. 
Repeat these steps for the Marketing show and close the dialog box. 

18. Run the full slide show, 12 slides will be displayed. Start the show again 
and use the Finance button to see the shortened custom show, 
advancing by clicking. This is easier than using the menus. Notice the 
slide numbers at the bottom right of the slides. 

19. Save the presentation and leave it open. 
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Driving Lesson 43 - Applying Transitions 

 Park and Read 
To add interest to a slide show, a transition can be applied to slides. This is a 
special effect, which controls how one slide changes to the next. Timings can 
be applied to the effects, so that they appear after a specified interval, or they 
can be displayed manually by clicking the mouse. 

 Manoeuvres 
1. In Slide Sorter View, select slide 1. 

2. To create a transition effect, display the Animations tab, and click the 
More arrow in the Transitions gallery. 

 
3. Select any effect from the list of transition effects shown. A demonstration 

of the effect is shown. 

4. Try using some of the other effects to see what they do, then 
select Dissolve. 

5. Click the drop down button for Transition Speed  

 

6. Select the speed Medium. 

7. In Advance Slide options, select On Mouse Click, then click Apply To 
All. All slides now have the Dissolve transition effect applied. 

 Each slide can have a different effect if desired, although normally they would 
all be the same. To apply an individual effect, select the slide, choose an effect 
from the Transition to this Slide Group, but do not click Apply to All. 

8. Select the first slide, then view the slide show. Click the mouse button to 
move through all the slides and notice the effects as the slides change. 

 
 
 
 

More 
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Driving Lesson 43 - Continued 

 A slide that has a transition applied has a  symbol underneath it in Slide 
Sorter view. 

9. To apply timings to the transition effects select slide 1. 

10. At the moment slide transitions do not start until the mouse is clicked. 
Select the Animations tab. Under Advance Slide, remove the check 
from On Mouse Click, then check Automatically After. 

11. Use the up spinner to increase the time to 5 seconds: 

 

12. Click Apply to All. Switch to Slide Sorter View. The transition timing for 
each slide is now shown underneath the slide image. 

 
13. View the slide show. The slides advance every 5 seconds without the 

need for clicking. Using this option the slide show could be left to run 
without the need for a presenter, as a continuously running display for 
example. 

14. When the show ends, remove the check from Automatically After and 
select On Mouse Click again. Click Apply To All. This has removed the 
transition timings. 

 It is possible to select both Advance Slide options (mouse click and automatic) 
at the same time. Then each transition can be activated by using the mouse if 
required, but if this is not used within the set time, the transition will start 
automatically. 

15. Save the presentation and leave it open for the next exercise. 
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Driving Lesson 44 - Applying Timings 

 Park and Read 
Instead of applying timings to slide transitions, slide shows can also have 
timings applied to each slide separately. This means that enough time can be 
allowed to describe each particular slide. These timings are set up during a 
Rehearsal. 

 If a presentation contains hyperlinks and action buttons it should be run 
manually, so that the links can be used. 

 Manoeuvres 
1. In Slide Sorter View, select the first slide and to apply timings select 

Slide Show tab and select Rehearse Timings from the Set Up group. 

2.  The slide show begins, with the Rehearsal dialog box on the screen. 

 

3. Allow enough time to talk about the slide then click the Next button, . 
The next screen appears with the time for the current slide reset to zero. 

4. Pause the rehearsal by clicking , then restart it using the same button. 
Move to the next slide/effect. 

5. View the entire presentation, clicking the Next button after the required 
time period for each slide until finished. 

6. At the end of the rehearsal a dialog box appears showing the total time for 
the slide show and asking if the timings are to be saved for future use.  

 
7. Click Yes. The individual times for each slide are now displayed. The total 

time for the slide show is made up of these times. The timings can be 
changed at any time by clicking the Rehearse Timings button again. 

8. Individual timings can still be amended. Click on slide 3. In the 
Animations tab, increase the Advance slide time value by 5 seconds. 

9. Save the presentation and leave it open. 
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Driving Lesson 45 - Setting up a Slide Show 

 Park and Read 
A slide show can be set up to run in a few different ways. It can be run 
manually, by clicking the mouse, or automatically using timings. It can also be 
set up to loop, running continuously. Note that even when timings have been 
applied to a show, you should check to make sure that it has been set up to use 
these timings. 

 Manoeuvres 
1. To make sure the timings specified earlier are to be used when the show 

runs, display the Slide Show tab and select Set Up Show. 

2. In the Set Up Show dialog box under Advance slides, select the option 
Using timings, if present. 

 
3. Click OK, then save the presentation. View the slide show, which will now 

play using the timings set in the rehearsal. There is no need to click the 
mouse. 

4. Select the Slide Show tab and select Set Up Slide Show. 

5. To disable the timings, select Manually under Advance slides. Click OK. 

6. Click on the first slide and then view the show. 
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Driving Lesson 45 - Continued 
7. The first slide in the presentation appears. Click the mouse to move to the 

second slide. 

8. Move through the rest of the slide show.  

9. At the end of the show change the set up within the Set Up Show dialog 
box to use timings again, but don’t click OK yet (the show could still be 
advanced using the mouse if desired). 

10. To make the show run continuously, check Loop continuously until 
‘Esc’. 

 
11. Click OK. 

12. View the slide show again and when the end is reached, the show will 
start again. 

13. Press <Esc> to end the slide show. 

14. To stop the show looping, select Set Up Show from the Slide Show tab 
and uncheck Loop continuously…. 

15. Click OK. 

16. Save and close the presentation. 

17. Open the presentation Holiday Choice. 

18. Apply  to the picture on slide 1. Choose an Entrance 
effect of Fly In, 

19. Set Direction to From Left and use the Timing option so that it starts 
after the previous event with a delay of 3 seconds. 

20. View the show for this slide only. 

21. The show can also be run without animation. Select the Slide Show tab 
and click Set Up Slide Show button. 

22. Under Show options, check Show without animation and click OK. 

23. View the show for this slide again and notice how the picture is not 
animated. 

24. Close the presentation without saving. 
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Driving Lesson 46 - Slide Show Techniques 

 Park and Read 
While running a show, you may need to pause to expand on a particular point, 
or indicate areas on a slide. There are various ways of controlling the show and 
being able to do just that. 

 Manoeuvres 
1. Open the presentation Theatre.  

2. Display the Slide Show tab and start the slide show. Click to move to 
slide 2. Right click on the screen to display a menu of options. 

 Some of these options are also available as buttons (almost hidden) in the 
lower left corner of the screen. 

3. From the shortcut menu, select Pointer Options | Felt Tip Pen. You are 
going to annotate the slide. 

4. Click and drag to draw a line beneath newly refurbished. This method 
could be used to emphasise a point as the show is presented. 

5. Right click and select Pointer Options | Eraser. Click with the eraser on 
the line to remove the pen mark. 

6. Right click and select Pointer Options | Arrow, then click to advance to 
slide 3. Slides will only advance when the Arrow option is active. 

7. At this point, you may wish to pause for questions. So there are no 
distractions, right click and select Screen | Black Screen. Right click and 
select Screen | White Screen for a different effect. 

 In some versions of PowerPoint, White Screen is not available. 

8. Click to resume the show. To end the show at any time either press 
<Esc> or right click and select  End Show. 

9. Apply a transition effect of your choice to all slides, with automatic timing 
of 5 seconds. 

10. When timings are applied the show can be paused during its progress. 
Start the slide show and let it continue to slide 3. 

11. Right click and select Pause to pause the show. 

12. Right click again and select Resume to start it again. Let the show 
continue to the end and the click to exit. 

13. Close the presentation without saving. 
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Driving Lesson 47 - Revision 
This is not an ECDL test. Testing may only be carried out through certified 
ECDL test centres. This covers the features introduced in this section. Try not to 
refer to the preceding Driving Lessons while completing it. 

1. Open the Kittens presentation. 

2. Create a custom show called Information consisting of slides 3, 4, 5 and 
8. 

3. Create a second custom show called Charity consisting of slides 2, 6 and 
7. 

4. Create an action button for each custom show on slide 1, one at the 
bottom left of the slide and one at the bottom right. 

5. View the slide show from slide 1 and use the action buttons to view each 
custom show in turn. 

6. Use the Ballpoint Pen option to draw on slide 2 in the Charity custom 
show - underline How to make a donation. 

7. Change back to the Arrow pointer option. 

8. Pause the show by displaying a black screen, the restart it. 

9. End the slide show. A message will ask if you want to keep your ink 
annotations, click Discard.  

10. Save the presentation as Shelter and close it. 

 
 
 
 
 
 
 
 
 
 
 
 

If you experienced any difficulty completing this Revision refer back to the 
Driving Lessons in this section. Then redo the Revision. 
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Driving Lesson 48 - Revision 
This is not an ECDL test. Testing may only be carried out through certified 
ECDL test centres. This covers the features introduced in this section. Try not to 
refer to the preceding Driving Lessons while completing it. 

1. Open the presentation CIA Seminar. 

2. Apply a Cover Down slide transition to all slides. 

3. All transitions should be advanced automatically after 5 seconds, but 
also leave the On mouse click option selected. 

4. Set the Transition Speed to Slow. 

5. Set up the show to use timings and to loop continuously. 

6. View the slide show. Use the mouse button on a few slides to override the 
timings and display a black screen while viewing slide 3. 

7. Continue the show. 

8. After it starts for the second time press <Esc>. 

9. Remove the option to loop continuously. 

10. Rehearse timings for the show, advancing slide 1 after about 10 seconds 
and all others after about 15 seconds. 

11. Save the timings.  

12. Save the presentation as Seminar Complete. 

13. View the slide show again. 

14. Close the presentation. 

 
 
 
 
 
 
 
 
If you experienced any difficulty completing this Revision refer back to the 
Driving Lessons in this section. Then redo the Revision. 
Once you are confident with the features, complete the Record of Achievement 
Matrix referring to the section at the end of the guide. 


